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FTD Document Center

The FTD Document Center allows you to create templates for email messages that you will send 
from FTD Mercury. You can create several different delivery confirmation templates, as well as email 
cover letters that can be sent out with statements and invoices.

If you are using delivery confirmation, FTD Mercury allows you to select different templates for local 
and outgoing orders. Sample templates are available to view in the FTD Document Center; 
however you must create your own templates to use in FTD Mercury. You can open the sample 
templates, customize them to your needs, and save them under a different name.

To create and use email templates in FTD Mercury, first create the template in the FTD Document 
Center. The FTD Document Center allows you to create custom templates by importing your own 
graphics, customizing the font, background, and merging data fields to create personalized 
templates. After the templates are created, use the Email option in Mercury Administration to select 
which template you want to use for an email cover letter, and assign templates to different delivery 
confirmation order types (local and outgoing). See Email Screen on page 24–24 for details.

Opening the FTD Document Center
TASK To open the FTD Document Center from Within FTD Mercury:

On the Tools menu, click Doc Center.

TASK To open the FTD Document Center when FTD Mercury Is Not Open:

Double-click the FTD Document Center icon on your Windows desktop.

Once launched, the main window opens and the Select a template to edit window displays. From 
this window you can select a template to edit, or you can create a new template.

NOTE This section teaches you about the basic functions of the FTD Document Center, such as creating new 
templates and document components. For more detailed information on the FTD Document Center, see 
the online manual. To access the online manual, click the Help menu in the FTD Document Center menu 
bar, then click Help.

Creating a New Template
TASK To create a new template when FTD Document Center is open:

1 If the Select a template to edit window is open, click New. If it is not open, on the Template 
menu, click New.

NOTE You can only have one template open at a time.
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2 Provide a name, type, short description, and long description for this template. See Create a 
New Template Window on page 23–2 for details about these fields.

3 Click OK to create the new template.

The FTD Document Center then takes you to a blank page, where you can begin selecting 
components to include in your template.

NOTE When designing your new template, make sure to save it frequently. To do this, click the Template in the 
menu bar, then click Save.

Create a New Template Window
The Create a new template window allows you to provide information about your new template, 
including its name, type, and description. It contains the following fields:

Figure 23-1: Create a New Template Window

Table 23-1: Create a New Template Window Fields

Field Description

Name Enter the file name of the new template in this field. Valid characters in this field are 
alphabetic, numeric, and the underscore “_” character. This field is limited to 
twenty characters.

Type Select the type of template. You can select Delivery Confirmation or Email Cover 
Letter. 

Short Description Provide a brief description of this template. This field is limited to fifty characters. 
This description displays as the template name in Mercury Administration.

Long Description Enter a detailed description of the template. This field is limited to 256 characters. 
This field is used for additional description for the template when viewing within 
the Document Center.



Opening an Existing Template 23–3

Opening an Existing Template
TASK To open an existing template when the FTD Document Center is not open:

1 Open the FTD Document Center.
2 In the Select a template to edit window, highlight the template name you want to edit and 

click OK.

TASK To open an existing template when the FTD Document Center is open:

1 On the Template menu, click Open.
2 In the Select a template to edit window, highlight the template name you want to edit and 

click OK.

NOTE Only one template can be open at a time.

Customizing Templates
A template can be defined as a series of components, for example graphics, text, etc. The 
components that make up the template are listed in the Components section. If you are creating a 
new template, the only component that displays is the Document component. As you add 
components, they are listed in the same order that they appear in the template, from top to 
bottom.

Figure 23-2: Components Selection

Adding Components to Your Template
TASK  To add a component to the template:

1 In FTD Document Center, click Add.
2 In the Select a component window, select the component that you want to add and click OK.

NOTE When inserting large graphics, you may receive a warning message that the image size exceeds the 
recommended size; this is normal.
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Figure 23-3: Select a Component Window

Sample Template with Components
Below is a sample template to give you an idea of what each of the components can look like in 
your template (keep in mind that font, alignment, graphics, etc. can be customized). 

Figure 23-4: Sample Email Template

Changing Component Order
The components display in the same order that they are listed in the Components list box. 
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TASK To change the order in which a component displays in the Template Mockup window:

1 Select the component in the Components list.
2 Click the Up or Down arrows to move the selected component up or down in the template.

Template Components
Below are brief descriptions for each of the components. Read through the component 
descriptions and decide which components you want to insert in your template.

Table 23-2: Available Components

Component Description

Document This component does not display in the Select a Component pop up box but is 
listed in the Components list box in the main window. Every template has a 
Document component. The Document component allows you to write a subject 
line for the email template and customize the background color and image to be 
used on the template (if any).

You will want to write a subject line for the template, otherwise the subject line 
for the email is read as “no subject” in the customer’s inbox. Since most customer 
email inboxes are cluttered with mail, create a subject line that will properly 
identify the email, such as “Kristin’s Florist thanks you for your order!”

Available properties include:

» Subject line—The text that will display in the subject line of the email 
message that the recipient will receive.

» Background color—The background color of the template.
» Background image—The image or wallpaper that will be displayed behind 

the entire template. The background image will not display in the mockup; it 
will be indicated by a light pink background. Use the Preview button in 
toolbar to preview the background.

» Use background image—Dictates if the background image will be used.

Address with Logo This component allows you to insert an address block that has a logo. You can 
type your store name and address, and select the graphic to use (you can select 
from a list of provided graphics or import your own). See “Graphic” below for 
graphic rules and instructions on using your own graphics.

Card Message This component should be used for delivery confirmation email templates only. 
If you insert the Card Message component, the card message from the 
customer’s order will be included in the email. It will display as “Card Message 
Line One, Card Message Line Two,” etc. in the template, however when the 
delivery confirmation email is sent, the customer’s card message from the order 
will be merged into the email.
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Graphic The Graphic component allows you to display a standalone graphic into the 
template. You can select from a list of provided graphics or import your own. 
(Only graphics with the following file extensions can be used: .gif, .jpg or .jpeg.)

TASK: To import your own graphic into the template, you can do either of the 
following:

Double-click Graphic in the Insert a Component pop up box, then click Insert 
to navigate and select the graphic file that you want to use. This copies the 
file to C:\Wings\DocCenter\images and it will be available to insert from 
the FTD Document Center.

OR

Place the graphic file(s) into C:\Wings\DocCenter\images. The graphic 
file(s) will then be available to insert from the FTD Document Center.

Graphic with Caption The Graphic with Caption component displays a graphic with text below it. You 
can customize the graphic, alignment, and font. (See “Graphic” above for graphic 
rules and instructions on using your own graphics.)

Graphic with Text The Graphic with Text component displays a graphic with text on the side of it. 
You can customize the graphic, alignment, and font. (See “Graphic” above for 
graphic rules and instructions on using your own graphics.)

NOTE: If you insert a graphic that is too wide for the mockup screen to 
properly display the graphic and text, you receive the message 
“Warning! Image size exceeds recommended size.” The image can 
still be inserted into the mockup screen, but you may not be able to 
see the “Replace with your text” text that is displayed next to the 
graphic. Make sure that you double-click on the text editor to type 
in your text (or else “Replace with your text” will be sent out with 
the email). (You may receive the warning message when inserting 
additional graphics [of normal size] into your template – this is 
normal.)

Marquee The Marquee component displays a scrolling line of text. The line of text does 
NOT scroll in the Template Mockup window. To see the text scroll, click the Print 
Preview button in the toolbar.

NOTE: As the customer is viewing the email, the marquee may not scroll 
across the screen, depending on the email program that the 
customer is using.

Product List This component should be used for delivery confirmation email templates only. 
The Product List component displays a list of the products in the order. You can 
customize which product information should display (product totals, discounts, 
delivery charges and service fees, etc.) and how fonts should appear.

NOTE: The product list that is inserted into the Template Mockup window 
is not the product information that is sent to the customer. When 
the delivery confirmation email is sent, the customer’s product 
information from the order is merged into the email.

Text The Text component displays a block of text. You can customize the font and 
alignment of the text.

Table 23-2: Available Components (cont.)

Component Description
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Changing Component Properties
After inserting components into your template, you will then want to change the way they look. 
You can do this by changing the component properties.

Figure 23-5: Component Properties Section

TASK To change component properties:

1 In the Components list, select the component that you want to change, and the current 
properties of that component displays in the Properties grid.

2 Each component has a series of properties that can be used to change the content and 
appearance of the component. For example, the text in the example above has a 12pt 
underlined font, and is centered in the template. To change the alignment for example, double-
click on CENTER. You are then taken to a window that allows you to change the alignment and 
save.

Inserting Merge Fields
You can include personalized customer and order information in the email (such as customer name, 
recipient information, etc.) by inserting merge fields. Merge fields act as placeholders for specific 
customer data that you have saved in FTD Mercury. When the email is sent, those placeholders are 
replaced with actual data.

Figure 23-6: Inserting Merge Fields
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Merge fields are placed within text. Therefore, first insert a Text component and then customize 
text.

TASK To insert a Text component and add a merge field:

1 With your template on the screen, click Add.
2 Highlight Text and then click OK.
3 Double-click on the existing text value (Replace with your text!).
4 A text editor displays with the default text. Delete this text and type your own text.
5 To insert a merge field, click the arrow in the list at the bottom to display the possible options. 

Select the merge field and click Insert. 
6 When you are finished, click OK and the text displays in the Template Mockup window.

Saving the Template
When you are finished customizing your template, save it in the FTD Document Center.

TASK To save your template:

On the Template menu, click Save.

Exiting the FTD Document Center
TASK To exit the FTD Document Center

On the File menu, click Exit.


